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Autumn Is The Most

 Beautiful Season Of The Year!

Microsoft Excel: Special Functions

We are sure that you all enjoyed
September's presentation on the cre-
ation of videos for YouTube, MySpace
or FaceBook.
We are looking
forward to view
all of your cre-
ations very
soon.

You are all in-
vited to atend this month's presenta-
tion of "Microsoft Excel: Special Func-
tions.  Richard Botting and Art Frenz,
both MCUG members will present things
you can do with Excel.  Art will demon-
strate how to build a name and address
database and how to do a mail merge to
create form letters and mailing labels.
Richard will also demonstrate some un-
usual and perhaps unknown capabilities
of Excel like some scale construction
drawings.  Please bring or send ques-
tions you may have regarding how to use
Excel.
As usual, the meeting will be in the Wil-
son Lecture Hall at Young Harris Col-
lege in Young Harris, Georgia.  It will be
on October 10, 2011 .  The Q&A seg-
ment will be at 6:00 P.M., meeting at
6:50 P.M. and the program will take place
at 7:00 P.M.  Please bring a Friend!
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MCUG Monthly Meeting Schedule
The regular monthly meeting of the Mountain Computer User

Group (MCUG)  is held on the second Monday of every month,

at 7 p.m., in the Wilson Lecture Hall (Room 201) of the

Goolsby Building on the campus of Young Harris College in

Young Harris, GA.

All regular monthly meetings and SIGs are open to everyone

regardless of membership status.

MCUG Membership
Annual dues are $20 and extend membership privileges to

two (2) members of a household. Membership privileges in-

clude: special discounts on vendor products, access to prod-

ucts for evaluation and review, and association with a great

bunch of people.

Affiliation
The Mountain Computer User Group is a member of

APCUG, a nonprofit international organization dedicated

to promoting communications between PC user groups and

the computer industry.

Group Purpose
The Mountain Computer User Group is a nonprofit, tax-

exempt educational organization without corporate or ven-

dor affiliation. Its purpose is the encouragement and ad-

vancement of computer information and knowledge through

“users helping users”.
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Family Tree Maker (Part 2)
Review by Mary Phillips, Secretary, Icon Users
Group, MO

March 2011 issue, The ICON-Newsletter of the
Interactive Computer Owners Network

www.iconusersgroup.org
mphillip1.mary@gmail.com

I’m going to show you how to use another of the
new features in FTM 2010/2011, Inserting a
family photo to the top of a Family Group
Sheet.

Create a Family Group Sheet by the following:
1. On the Family tab of the People

workspace, select one of the

parents’ names, then click the

Publish tab.
2. Click Relationship Reports, and

select Family Group Sheet.

3. On the right side of the page, click

the Create Report button.

4. Click the Save Report icon under

Family Group Sheet Options. Name

the report; click Save.

5. The report can be opened by

clicking the Publish tab and then

Saved Reports.

Before a photo can be used as the family
picture on a Family Group Sheet, it needs to be
assigned as Media to the Relationship for the
parents.

1. Again, on the Family tab of the People
workspace, select the same parent’s name,
then click on the Marriage facts button.

2. In the window that appears, click on the
Media tab at the top.

Continued on page 7
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MEET NEW DIRECTOR RICHARD BOTTING!
New director, Richard Botting, was born in Buenos Aires, Argentina.  After doing his military
service in the Argentine Air Force, assigned to the USAF Mission, he immigrated to the US going to
college in San Francisco.

Upon completion of his studies, he moved to the Fort Lauderdale, FL, area where he spent the next 33
years running his construction equipment company.  SCUBA diving, water skiing, coaching and refereeing
soccer kept him and his boys busy for many years.

Although computers are not in his background, he realized that computers were the way of the
future in running ones business and bought his first IBM
with a whopping 64K of memory and two 5 1/4” floppy
disk drives in 1982.  With modifications and additions,
Richard was still using that computer 15 years later as
a remote work station to an IBM system 36.  He
presently has far more state of the art equipment, an
eight year old Dell desktop and five year old laptop.

Richard and his wife Maddie moved to Hiawassee in
early 2002 where they purchased a rental business
which they operated as Georgia Carolina Rentals till
June of 2008, when they decided that the bleak economic
future made for a good time to sell up and retire.  While
crawling the walls due to inactivity, Maddie volunteered
him to help at the then recently opened Towns County

Food Pantry, which he has been helping to operate ever since.  To quote him, “If I had known about
the lack of stress and the fun in volunteering, I would have retired years ago”
Richard and Maddie have six children and fourteen grand brats (as he tends to call them) spread out
from the Pennsylvania Poconos to Chicago and down to Pompano Beach and Gainesville, Florida.

When not reading and listening to classical music, you can usually find him procrastinating on the
remodeling of their home, watching his first loves, Rugby or Formula 1 racing.

First Patented Programmable Calculator Designer Has Local Ties
The Mathatron is the first programmable electronic calculator that could fit on a desk and be
easily used by an individual. Earlier “electronic calculators” were really
mainframe computers that took up a large amount of space and weren’t user-
friendly. The Mathatron was a ground-breaking machine, since it could be
easily used by a person for regular calculations as well as being able to be
keystroke-programmed to solve repetitive problems. One could say that the
Mathatron might possibly be the first device that could be called a “desktop
computer” or “personal computer”.  This machine was the brainchild of three
men: William Kahn, Roy Reach, and David Shapiro, who worked on the design
of the machine in the early 1960s in Waltham, Massachusetts. The name
“Mathatron” was coined my Mr. Reach’s wife, Marjorie (Marge).  Marge now resides in Blairsville
and is active in the Blairsville Garden Club.

mathatron highlights: Program memory (core), 24 to 480 steps Addressable storage, to 88 registers

9 significant digits, exponent, and sign Number range ±j10-42 to 10+58
Speed 100 accumulations per second Optional prewired programs for special

applications.
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Tom's Tip of the Month

Brother B&W Laser Printer HL-2170W, USB
or wireless, Needs Toner Cartridge ($32.73 at
Buy.com) Printer sells for from $109. to $149.

asking $24.95

 Call George @ (706)379-0663

2 New Epson Black ink cartridges
S020187/S020093

$5 each
Call Roger Hove @ (706) 781-8653

BITS & PCs
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HP Photosmart Premmum AiO

Wrls prntr w/8 mos. left on ext.

warranty. Incl. 5 new ink cartridges.

$55

Call Roger @ (706) 781-8653

For all of you who are seeking news from
other areas of the country, this is a cool
website for you to accomplish this in only
one spot.

http://www.newseum.org/
todaysfrontpages/flash/

Just put your mouse on a city anywhere in
the world and the newspaper headlines pop
up...

Double click and the page gets larger...you
can read the entire paper on some if you
click on the right place. You can spend
forever here.

Also, if you look at the European papers,
the far left side of Germany will pop up as
The Stars & Stripes (European edition, of
course).

AND, this site changes every day with the
publication of new editions of the papers.

The Humorous Side

Lexiphile: (i.e., “lovers of words” you know . . . .
like . . . you can tune a piano, but you can’t tuna
fish . . .. or, I wondered why the baseball was
getting bigger . . . . then it hit me . . . .etc.).

Well, here are a few more:

To write with a broken pencil is . . . pointless.

When fish are in schools they sometimes . . .
take debate.

The batteries were given out . . . free of
charge.

A dentist and a manicurist married. .. . . They
fought tooth and nail.

A will is a . . . dead giveaway.

With her marriage, she got a new name . .. . and
a dress.

You are stuck with your debt if . . . you can’t
budge it.

A boiled egg is . . . hard to beat.

Police were called to a day care where a three-
year-old was . . .. resisting a rest.

Did you hear about the fellow whose whole left
side was cut off? . . . He’s all right now.

If you take a laptop computer for a run you
could . . . jog your memory.

In a democracy it’s your vote that counts; in
feudalism, . . . it’s your Count that votes.

When a clock is hungry . . .. it goes back four
seconds.

The guy who fell onto an upholstery machine . . .
was fully recovered.

He had a photographic memory . . . which was
never developed.

Those who get too big for their britches will be
. . . exposed in the end.

When she saw her first strands of gray hair, . .
. she thought she’d dye.
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What’s All This Cloud Stuff, Anyhow?*

By Greg Skalka, President, UCHUG (Under the Computer Hood UG), California

July 2011 issue, DriveLight ................www.uchug.org president@uchug.org

Cloud computing is supposed to be the next big thing. Microsoft has commercials showing people
delayed at an airport watching TV show episodes “in the cloud”. Lots of big companies like Amazon,
HP, IBM, Dell and AT&T are pushing their own version of the “cloud”. Even Apple is introducing
iCloud. What does it really mean? Will our stuff be in the public cloud, private cloud or both? Is it
going to give us more capabilities, help us save money and have all our stuff available anywhere we
want it, or will we only get rain and overcast from the “cloud?”

Cloud computing involves getting data, applications and services over the Internet. You might have
your photos, music and other files stored on someone else’s servers, rather than on your computer.
This would allow you to access those files from any computer connected to the Internet. You might
run web-based applications that allow you to perform the same functions as an office productivity
suite, like document and spreadsheet creation, without having any office software installed on your
PC. You might get your email through a web-based system and interface. For all the hype, though, it
seems that “cloud” is just another word for the Internet.

Is the cloud just a return to the dumb terminals connected to the computer mainframe model of
computing, with the Internet now doing the connecting?

Most of us are already doing things in the cloud. If you have used Google Gmail on the web, filed your
taxes with the online version of TurboTax, shared photos on Flickr or checked out your friends on
Facebook, you’ve had your head in the cloud. Even if you host photos on your (home) network hard
drive that can be accessed by others over the Internet, that is your own private cloud. Think about
that the next time you are using Amazon’s Cloud Drive to store and listen to your MP3 of The Rolling
Stones’ “Get Off Of My Cloud.”

One thing that appears obvious to me is that we are each dealing with more information, larger files
and larger bandwidth streams than ever before. Without a high-bandwidth Internet connection,
cloud computing would not be feasible for an individual. No one will be accessing the cloud with dial-
up. As our files get larger, passing them between the cloud and your PC takes more time or bandwidth.
While some might be pushing more megapixels in digital cameras and advocating streaming HD video,
these trends further challenge the utility of the cloud concept.

Using cloud storage can be great way to share photos and videos. It is about the only way to share
the large JPEG files that new 10+ megapixel cameras take. You sure can’t email those large files, and
no one wants to wait for the CD (or DVD) of photos from the family gathering to arrive in the mail.
The problem with the cloud is it can still take a long time to upload and download large files, even
with a broadband Internet connection.

This indicates to me that the cloud concept could be a farce in some cases. Every new camera I buy
has more megapixels, but if I have to spend hours uploading the photos from my camera to the cloud,
and people spend hours tediously downloading, it does not seem like progress. If I have to resize my
photos to put them in the cloud (as my primary, or only storage), then why are these camera
manufacturers working so hard to sell me on more resolution?

And don’t get me started on the security concerns of computing in the cloud, or you’ll really have me
singing “Get Off Of My Cloud.”
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A Few Tips for Customizing Word 2007

By Nancy DeMarte, Columnist, Office Talk, Sarasota PCUG, Inc., Florida

July 2011 issue, Sarasota PC Monitor www.spcug.org ndemarte@Verizon.net

When creating Office 2007 programs, Microsoft added new tools and settings designed to save
time and simplify tasks for users. Some of us find that while we appreciate most of these features,
a few are getting in our way.  Fortunately, many of these default settings can be disabled or
modified. Here are a few customizations that I have found to be helpful.

Add commands to the Quick Access toolbar: Let us say that you use a certain
command often, like the Spelling & Grammar checker, but keep forgetting where
it is located in the Word 2007 ribbon. There is an easy solution. You can copy
any command to the Quick Access toolbar, which is always visible in the top left
corner of the Word window above the Office button. To place a tool button
there, first find it on the ribbon, right click it and select Add to Quick Access
toolbar. If you have several commands you want to move there, start by clicking
the arrow to the right of the Quick Access toolbar. Then click a command you

want from the list, which puts a checkmark next to it and adds
it to the Quick Access toolbar. You may have to click More
commands to expand the list. In this view, click a command in the left pane, and
then click Add to put it on the Quick Access toolbar, shown in the right pane.
Repeat for as many commands as you want, then click OK. Tip: Be a bit selective
or your Quick Access toolbar may get so long it blocks out the title of your
document.

Control the space between lines and paragraphs in your customized Normal
template: In August 2010, I wrote a Monitor article about how to customize the
Normal Template in Word 2007 on which all new documents are based.

Recently, I learned that even making those changes does not rid your documents of the extra space
between the lines and paragraphs. Apparently, even Microsoft acknowledges that the Word 2007
line spacing rules are not easy to change.

Word 2003 and earlier versions used single spacing between lines and after paragraphs, which is
what many users would like to get back. Word 2007’s default setting is 1.15 pts between lines and
1.15 plus a blank line after paragraphs.  A fairly easy way to revert your Word 2007 spacing
back to the 2003 version is by changing the Style Set. Open a Word 2007 document. Click the
Home tab, and then click Change Styles in the Styles group. Point to Style Set and click Word

2003. To make the new style set become the default in Word 2007, click
Change Styles again, and then click Set as Default.  If you prefer not to
go through all those steps, Microsoft has created a little fix-it tool which
will make these changes for you. You can download it from the Microsoft
website at this address:

http://support.microsoft.com/kb/921174.

Create Custom Page Margins:  If the margins in your document are not
set the way you want them, you can fairly easily change the margins to
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your liking. With your document open, click the Page Layout tab, and then click Margins in the
Page Setup group. The Normal setting for Word 2007 is 1 inch on all sides - top, bottom, left and
right. Several other choices appear in the drop down gallery. If you like one of these, merely click
it and watch your document change to the new margin settings.

If you do not find what you want in the margins gallery, you can create your own customized
margins.  Open the Margins gallery and click Custom Margins, which opens the Page Setup dialog
box. On the Margins tab, type your desired settings in the four boxes, leaving Gutter (the area
left for binding or hole-punching) at “0” and “left.”  If you want these new margins in effect for
only the current document, click OK. If you want to use them for this and future documents, click
Default, and then OK.

Add the Right Kind of Date to Your Document: Many of us like to put dates in
our documents to identify when they were written. But when we open some
documents, we find the current date rather than the date it was composed.
Word allows us to enter two sorts of dates and times: a date which never
changes or a date which updates automatically whenever the document is
opened. It helps to know how to enter both types since there are occasions
when each is appropriate.

To enter a static date, just type it somewhere in the document or footer.
Another way is to click the Insert tab and, in the Text group, click Date &
Time. This opens a dialog box where you can choose from several formats for
the date and/or time. Be sure to uncheck the box next to Update
automatically if you want the date to remain static.

To enter a date that updates each time you open the document, click the Date & Time button as
explained above. This time be sure that Update automatically is checked.

A way to add a date with specific properties is to add a date “field.” Click the Insert tab, then
Quick Parts, then Field. In the Field box, select the Date and Time category. Here you will find
several specialized fields, such as CreateDate, PrintDate, and SaveDate. A quick way to insert a
field for a date is to use the keystroke shortcut, [Shift]+[Alt]+[D].

Get rid of the Mini Toolbar: Whenever you highlight a word or phrase in Word 2007, a mini
toolbar of editing commands appears above and almost covering the highlighted text, which can be
annoying. The mini toolbar is a new feature of Word 2007/2010.  Its purpose is to put the most
commonly used editing commands close to where you need them. For some this is a time-saver; for
others, it’s a pain.  Fortunately, you can turn off if it bothers you. To disable this feature, click
the Office button, then Word Options (bottom right), and then Popular. Remove the checkmark
from the box next to Show mini-bar on selection and click OK.

.continued from page 2

Next, click the drop down arrow beside New and select one of the choices: Add New Media
(import new photo from a folder on your computer), Link to Existing Media (attach a photo
already in your media gallery to this fact), or Scan Media (scan a photo from your scanner).

4. Click OK.

5. Now, to add this photo to the top of the Family Group Sheet, open the Family Group Sheet
from the Publish tab, Saved Reports.

6. Click on the Family Picture drop down menu on the right and change it from None to the
selected photo.
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Hatch Hatchell 10/01
Cathy Pearce 10/05
Laura Hove 10/14
Donald Miller 10/14

Art Frenz 10/15
Betty Rose Shope 10/22
Cissy Williams 10/23
Sandra Royals Shenkman 10/25
Jo Anne Allen 10/29
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HAPPY BIRTHDAY!!!

Bill & Vivan Heath 10/30/1959 52 yrs
Larry & Bonny Garrett 10/18/1969 41 yrs

Art & Diane Frenz 10/05/1973 38 yrs
Carole & Clifford Kasa 10/20/1985 26 yrs


